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3. MODELING A THREE-PIPE INTERSECTION (3-D) 

This tutorial employs “primitives”—that is, predefined GAMBIT modeling components 
and procedures. There are two types of GAMBIT primitives: 

• Geometry 

• Mesh 

Geometry primitives are volumes possessing standard shapes—such as bricks, cylinders, 
and spheres. Mesh primitives are standard mesh configurations. 

In this tutorial, you will use geometry primitives to create a three-pipe intersection. You 
will decompose this geometry into four parts and add boundary layers. Finally, you will 
mesh the three-pipe intersection and will employ a mesh primitive to mesh one part of the 
decomposed geometry. 

In this tutorial you will learn how to: 

• Create volumes by defining their dimensions 

• Split a volume 

• Use GAMBIT journal files 

• Add boundary layers to your geometry 

• Prepare the mesh to be read into POLYFLOW 

3.1 Prerequisites 

This tutorial assumes you have worked through Tutorial 1 and you are consequently 
familiar with the GAMBIT interface. 
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3.2 Problem Description 

The problem to be considered is shown schematically in Figure 3-1. The geometry 
consists of three intersecting pipes, each with a diameter of 6 units and a length of 4 units. 
The three pipes are orthogonal to each other. The geometry can be represented as three 
intersecting cylinders and a sphere octant at the corner of the intersection. 
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Figure 3-1: Problem specification 
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3.3 Strategy  

In this tutorial, you will quickly create the basic geometry for a three-pipe intersection. 
The basic geometry can be automatically meshed with tetrahedra, but your goal in this 
tutorial is to create a conformal, hexahedral mesh for POLYFLOW, which requires some 
decomposition of the geometry before meshing. Thus, the tutorial shows some of the typi-
cal procedures for decomposing a complicated geometry into “meshable” volumes. 

The first decomposition involves using a brick to split off a portion of the three-pipe inter-
section. The resulting volume is described as a sphere “octant” (one-eighth of a sphere) 
residing in the corner of the intersection, as shown in Figure 3-2. This volume, which is 
very similar in shape to a tetrahedron, will therefore be meshed using GAMBIT’s Tet 
Primitive scheme. Note that this creates a hexahedral mesh in a tetrahedral topology; it does 
not create tetrahedral cells. 

 

Figure 3-2: Decomposition of the three-pipe intersection geometry 

The remaining geometry is then split into three parts, one for each pipe, as shown in 
Figure 3-1. To do this, you will create an edge and three faces that are used to split the 
volume into the required three parts. These volumes are meshed using GAMBIT’s Cooper 
scheme (described in detail in the GAMBIT Modeling Guide). This tutorial illustrates 
three different ways to specify the source faces required by the Cooper scheme. 
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Two other helpful topics are covered in this tutorial: the use of journal files and the mesh-
ing of boundary layers. The journal file contains a record of all your command inputs to 
GAMBIT. This file can be edited and your inputs can be converted into variable parame-
ters that allow subsequent geometries (with changes in key dimensions, for example) to be 
quickly created and meshed. The boundary layer meshing tools in GAMBIT allow you to 
control how the mesh is refined near walls and other boundaries. 
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3.4 Procedure 

Start GAMBIT. 

Step 1: Select a Solver 

1. Choose the solver you will use to run your CFD calculation by selecting the following 
from the main menu bar: 

Solver → POLYFLOW 

The choice of a solver dictates the options available in various forms (for 
example, the boundary types available in the Specify Boundary Types form). The 
solver currently selected is indicated at the top of the GAMBIT GUI. 

Step 2: Create the Geometry 

1. Create the three pipes for the intersection. 

GEOMETRY  → VOLUME  → CREATE VOLUME R  

This command sequence opens the Create Real Cylinder form. 

 

a) Create the first pipe. 

i. Enter a Height of 10 in the Create Real Cylinder form. 

ii. Enter 3 for Radius 1. 
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The text entry box for Radius 2 can be left blank; GAMBIT will set this 
value by default to be the same value as Radius 1. 

iii. Select Positive Z (the default) in the list to the right of Axis Location. 

iv. Click Apply. 

b) Create the second pipe. Use the same Height and Radius 1 as above, and select 
Positive X in the list to the right of Axis Location. 

c) Create the third pipe. Use the same Height and Radius 1 as above, and select 
Positive Y in the list to the right of Axis Location. 

2. Click the FIT TO WINDOW command button , at the top left of the Global Control 
toolpad, to view all three cylinders. 

You can rotate the view by holding down the left mouse button and moving the 
mouse. The cylinders are shown in Figure 3-3. 

 

Figure 3-3: Three cylinders for the three-pipe intersection 
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3. Create a sphere to complete the basic geometry. 

GEOMETRY  → VOLUME  → CREATE VOLUME R  

This command sequence opens the Create Real Sphere form. 

 

a) Enter 3 for the Radius. 

b) Click Apply. 

4. Unite the four volumes into one volume. 

GEOMETRY  → VOLUME  → BOOLEAN OPERATIONS  

This command sequence opens the Unite Real Volumes form. 

 

a) Shift-left-click all of the volumes in the graphics window, and click Apply. 

These volumes will be united into one volume. The completed geometry is 
shown in Figure 3-4. 
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Figure 3-4: The completed geometry 
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Step 3: Decompose the Geometry 

It is possible to automatically mesh this full geometry using the TGrid scheme. 
However, it is not possible to automatically mesh this geometry with conformal 
hexahedra. In order to generate a conformal hexahedral mesh, you must now 
decompose the geometry into portions, each fulfilling the criteria of available 
hexahedral meshing schemes. In this example, you will create a brick that will be 
used to split the three-pipe volume, forming a sphere octant (one-eighth of a sphere) 
where the three pipes intersect. You will then create an edge, and use it to form three 
faces inside the geometry. These faces will be used to split the three-pipe intersection 
volume into three pipe sections. 

1. Create a brick. 

GEOMETRY  → VOLUME  → CREATE VOLUME R  

This command sequence opens the Create Real Brick form. 

 

a) Enter a value of 5 for the Width of the brick. 

GAMBIT will set the Depth and the Height of the brick to be the same as the 
Width if no values are entered in these fields in the form. 

b) Select -X -Y -Z in the list next to Direction. 

c) Click Apply. 

The view in the graphics window is shown in Figure 3-5. 
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Figure 3-5: Three-pipe geometry and brick 

2. Split the volume and create a sphere octant volume where the three pipes intersect. 

If you split one volume with another volume, the following volumes will result: 

• Volumes corresponding to the common region(s) from intersection. 

• Volumes corresponding to the region(s) defined by subtracting the second 
volume from the first. 

In other words, splitting a volume results in a combination of the intersection and 
subtraction Boolean operations. The order of selecting the volumes is important. 
For example, Figure 3-6 shows the difference between splitting volume A using 
volume B, and vice versa. 



MODELING A THREE-PIPE INTERSECTION (3-D) Procedure 

© Fluent Inc., May-03 3-11

A

B

Region of
intersection

(b) Split A with B

(c) Split B with A

B1 B2

A1 A2

(a) Original volumes

 

Figure 3-6: Splitting volumes 

 

GEOMETRY  → VOLUME  → SPLIT/MERGE VOLUMES  

This command sequence opens the Split Volume form. 
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a) Select the three-pipe volume in the graphics window. 

b) Select Volume (Real) as the Split With option. 

c) Left-click in the Volume list box located below the Split With section to make the 
Volume list box active. 

d) Unselect the Bidirectional option. 

e) Select the brick and click Apply to accept the selection. 

GAMBIT will split the three-pipe volume using the brick, leaving two 
volumes: the three pipes (volume.1) and the sphere octant (volume.3). 

3. Create a straight edge inside the three-pipe volume. 

GEOMETRY  → EDGE  → CREATE EDGE  

This command sequence opens the Create Straight Edge form. 
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a) Shift-left-click the vertex at the origin (Gx, Gy, Gz). 

b) Select the vertex that is shared by all three cylinders (x = y = z). 

c) Click Apply to accept the selected vertices and create an edge between them. 

The edge is shown in Figure 3-7 and will appear yellow in the graphics 
window. 

Edge

 

Figure 3-7: Straight edge created inside the volume 
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4. Create faces inside the three-pipe volume. 

GEOMETRY  → FACE  → FORM FACE  

This command sequence opens the Create Face From Wireframe form. 

 

a) Create a face inside the geometry using the edge created in the previous step. 

i. Select the edge created in the previous step. 

ii. Select a curved edge on one of the cylindrical surfaces that is connected to the 
edge just selected. 

iii. Select the edge that closes the loop. 

The three edges to be selected are shown in Figure 3-8. 
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Figure 3-8: Three edges used to create a face 

iv. Click Apply to accept the selection and create a face. 

The edge created in the previous step will turn blue. 

b) Create a second face by selecting the blue edge, a different curved edge connected 
to the blue edge, and the edge that closes the loop. 

c) Create a third face by selecting the blue edge, the third curved edge connected to 
the blue edge, and the edge that closes the loop. 

The three faces are shown in Figure 3-9. It may be useful to remove the 
volumes from the display; it is then easier to see the faces you created. The 
volumes are not deleted, just removed from the graphics window. To remove 
the volumes from the display, click the SPECIFY DISPLAY ATTRIBUTES 

command button  at the bottom of the Global Control toolpad. Select the 
check box to the left of Volumes. Select the Off radio button to the right of 
Visible near the bottom of the form, and click Apply. Turn the visibility of the 
volumes back on after you have examined the faces. 
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Figure 3-9: Three faces created inside the pipe intersection 

5. Split the three-pipe volume using the faces created in the previous step. 

GEOMETRY  → VOLUME  → SPLIT/MERGE VOLUMES  

This command sequence opens the Split Volume form. 
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a) Select the three-pipe volume in the graphics window. 

b) Select Face (Real) as the Split With option. 

c) Left-click in the Face list box located below the Split With section to make the Face 
list box active. 

d) Pick one of the internal faces created in the steps above. 

Shift-middle-click on a face if you need to deselect it and select the face next to 
it. 

e) Select the Bidirectional option. 

f) Click Apply to split the volume. 

g) Repeat Steps (a) through (f), using one of the other two internal faces to split the 
three-pipe volume. 

h) Repeat Steps (a) through (f) again, using the remaining internal face to split the 
three-pipe volume. 
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GAMBIT will create three volumes that are connected with common 
geometry. The decomposed geometry is shown in Figure 3-10 and is now 
ready to be meshed. 

 

Figure 3-10: Decomposed geometry 
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Step 4: Journal Files 

! Note that this step is not an essential part of the tutorial and is designed to provide 
information on using journal files in GAMBIT. 

Every time a GUI operation is performed in GAMBIT, the corresponding commands 
are automatically written to a journal file. This journal file, therefore, provides a 
backup copy of all the commands for the current session. 

Journal files can be used to recreate a geometry or mesh that was created in a 
previous session. You can view, run, and edit journal files in GAMBIT. See the 
GAMBIT User’s Guide for more information on journal files. 

1. View the journal file for the current GAMBIT session. 

File → Run Journal… 

This command sequence opens the Run Journal form. 

 

a) Select the Edit / Run Mode option at the top of the form. 

b) Click the Current Journal button. 

The File Name for the current journal file will appear in the form. 

c) Click Accept. 

This action opens the Edit/Run Journal form. You can see the journal file for 
the current session, showing every step completed. 
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2. Edit the current journal file. 

a) Left-click at the end of the first line and press the Enter key. 

GAMBIT will open a new line where you can type a command. 

b) Type reset in the new line. 

! If you run the journal file without executing the reset command, GAMBIT 
creates new geometry on  top of the existing geometry. 

3. Save the journal file with a new name. 

a) In the File Name text entry box at the bottom of the form, delete the text 
“GAMBIT.#####/jou”. 

##### is the process identifier for the current GAMBIT session. In the above 
form, ##### is 1283. 

b) Rename the journal file by typing 3pipe.geo in the File Name text entry box. 

c) Click the Save button at the bottom of the form. 

The file will be saved to your working directory. By saving the journal file to 
another name, you ensure that it will not be overwritten or appended.  
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4. Replay the steps you have taken in the current session. 

a) Hold down the right mouse button in the TEXT EDIT FIELD (this name will be dis-
played in the Description window when the mouse cursor is over this field) of the 
Edit/Run Journal form until a menu appears. Choose the Select All option in the 
menu. 

A black box in the LINE EXECUTION COLUMN of the Edit/Run Journal form 
indicates that a line is selected. Note that all lines are now marked with a 
black box. You can select/deselect individual lines by clicking the left mouse 
button on the arrow on the left side of the required line. 

b) Repeatedly click the Step button at the bottom of the Edit/Run Journal form until a 
cylinder appears in the graphics window. 

Note that GAMBIT’s current position in the journal file is marked by an 
asterisk in the LINE EXECUTION COLUMN of the Edit/Run Journal form. The 
Step button allows you to step through a journal file one line at a time. Each 
time the Step button is clicked, GAMBIT will execute the next highlighted 
line; it will skip any lines that are not highlighted. 

GAMBIT has used the information in the journal file to recreate the first 
cylinder you created in Step 2. 

c) Click the Step button again. 

A second cylinder appears in the graphics window. 

d) Click the Auto button in the Edit/Run Journal form. 

The Auto button allows you to automatically rerun a journal file. If the Auto 
button is used, GAMBIT will automatically execute all lines that are 
highlighted, and skip any lines that are not highlighted. GAMBIT just used 
your journal file to redo the geometry creation and decomposition for the 
three-pipe intersection. Each line of the journal file was displayed in the 
Transcript window as it was executed. 

e) Close the Edit/Run Journal form. 
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Step 5: Turn Off Automatic Smoothing of the Mesh 

It is necessary to turn off smoothing of the mesh in this example to prevent the 
boundary layers from being smoothed out during the volume meshing. 

Edit → Defaults… 

This command sequence opens the Edit Defaults form. 
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1. Select the MESH tab at the top of the form. 

This displays the types of meshing for which you can set defaults. 

2. Select the FACE radio button. 

GAMBIT displays the Variables for which defaults are set in a list in the Edit 
Defaults form. 

3. Select AUTO_SMOOTH in the Variable list. 

AUTO_SMOOTH will appear in the text entry box at the bottom of the list and its 
default value will appear in the Value text entry box. 

4. Enter a value of 0 in the Value text entry box. 

5. Click the Modify button to the left of AUTO_SMOOTH. 

The Value of the variable AUTO_SMOOTH will be updated in the list. 

6. Close the Edit Defaults form. 
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Step 6: Apply Boundary Layers at Walls 

Boundary layers are layers of elements growing out from a boundary into the 
domain. They are used to locally refine the mesh in the direction normal to a face or 
an edge. A single boundary layer can be attached to several face/edge pairs or 
volume/face pairs. The direction of the boundary layer is indicated during picking 
with an arrow that points towards the middle of the active face or volume. 

1. Create boundary layers on the edges where the sphere octant intersects the pipes. 

MESH  → BOUNDARY LAYER  → CREATE BOUNDARY LAYER  

This command sequence opens the Create Boundary Layer form. 
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a) Enter 0.1 next to First row under Definition. 

This defines the height of the first row of elements normal to the edge. 

b) Enter 1.4 next to Growth factor. 

This sets the ratio of distances between consecutive rows of elements. 

c) Move the slider box below Rows until the number of rows = 4. 

This defines the total number of element rows. Notice that GAMBIT updates 
the Depth automatically. The depth is the total height of the boundary layer. 
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d) Retain the default Algorithm (Uniform). 

e) Retain the default Transition pattern (1:1). 

f) Select one of the three curved edges where the sphere octant intersects the pipes 
(Figure 3-11). 

The boundary layer will be displayed on the edge. 

g) Check that the arrow indicating the direction of the boundary layer is pointing 
towards the origin (Gx, Gy, Gz). If it is not, Shift-middle-click the edge until the 
arrow is pointing in the correct direction. 

h) Select a second curved edge where the sphere octant intersects the pipes and 
ensure that the arrow on the edge is pointing towards the origin. 

i) Repeat for the third curved edge. 

The boundary layers will be displayed on the edges as shown in Figure 3-11. 

j) Click Apply in the Create Boundary Layer form to apply the boundary layers to the 
edges. 

 

Figure 3-11: Boundary layer on three edges of the sphere octant 
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2. Repeat the above steps to create the same boundary layer on the three curved edges 
where the three pipes intersect, as shown in Figure 3-12. Again, the arrows on the 
edges must point towards the origin. 

 

Figure 3-12: Boundary layers on the three edges where the pipes intersect 
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Step 7: Mesh the Sphere Octant Volume 

1. Mesh the sphere octant. 

MESH  → VOLUME  → MESH VOLUMES  

This command sequence opens the Mesh Volumes form. 

 

a) Select the sphere octant in the graphics window. 

GAMBIT automatically selects Hex Elements and the Tet Primitive Type under 
Scheme in the Mesh Volumes form, because the volume represents a logical 
tetrahedron. (NOTE: The Tet Primitive scheme divides a logical tetrahedron 
into four logical-hexahedral blocks and creates hexahedral mesh elements in 
each block. The Tet Primitive scheme does not create tetrahedral mesh 
elements. (See the GAMBIT Modeling Guide.)) 

b) Accept the default Interval size under Spacing in the Mesh Volumes form and click 
the Apply button at the bottom of the form. 

The mesh for the sphere octant is shown in Figure 3-13 Note the boundary 
layers you applied on three faces of the sphere octant. 
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Figure 3-13: Mesh on sphere octant 

2. Remove the mesh from the display before you mesh the three pipes. 

This makes it easier to see the edges and faces of the geometry. The mesh is not 
deleted, just removed from the graphics window. 

a) Click the SPECIFY DISPLAY ATTRIBUTES command button  at the bottom of 
the Global Control toolpad.  

b) Select the Off radio button to the right of Mesh near the bottom of the form. 

c) Click Apply and close the form. 

The boundary layers will still be visible in the graphics window. 
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Step 8: Mesh the Pipe Volumes 

You will now mesh the three pipes. These volumes will be meshed using GAMBIT's 
Cooper scheme (described in detail in the GAMBIT Modeling Guide). This tutorial 
illustrates three different ways to specify the source faces (the faces whose surface 
meshes are to be swept through the volume to form volume elements) required by the 
Cooper scheme. In the first example, you will modify the face vertex types for the side 
face of one pipe. This is the safest way to ensure correct meshing. In the second 
example, you will enforce the Submap scheme on the side face of the pipe. In the third 
example, you will enforce the Cooper meshing scheme for the volume and hand-pick 
all the source faces. 

1. Mesh one of the pipes by changing the vertex type on the wall face to Side and then 
using the Cooper meshing scheme to mesh the volume. 

By changing the vertex type to Side on the wall face of the pipe, you will enable 
GAMBIT to use the Submap scheme on this face. The criteria for the Cooper 
meshing scheme will then be fulfilled for the pipe, and the pipe can be meshed 
using the Cooper scheme. 

a) Change the vertex type on the wall face to Side. 

MESH  → FACE  → SET FACE VERTEX TYPES  

This command sequence opens the Set Face Vertex Type form. 

 

i. Select Side (the default) under Type. 
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ii. Select the wall face of the pipe (shown in Figure 3-14) in the graphics 
window. Note the vertex on the wall face marked with an “E” for End (where 
the three pipes intersect). 

Wall face of
first pipe

End vertex

 

Figure 3-14: Wall face of the first pipe volume showing the End vertex 

iii. Left-click in the Vertices list box. 

iv. Select the vertex that was marked with an “E” in the graphics window (where 
the three pipes intersect, as shown in Figure 3-14). 

v. Click Apply in the Set Face Vertex Type form. 

The vertex will be changed to Type “S” for Side. You will only see the 
vertex label if you reselect the face. A message will appear in the 
Transcript window stating that the vertex was set to type Side. 

b) Mesh the pipe volume using the Cooper meshing scheme. 

MESH  → VOLUME  → MESH VOLUMES  

This command sequence opens the Mesh Volumes form. 
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i. Select the first pipe volume in the graphics window. 

Note that Hex/Wedge Elements and the Cooper Type are automatically 
selected under Scheme in the Mesh Volumes form because you changed 
the vertex type on the wall face to Side. 

GAMBIT automatically selects the source faces because you changed the 
vertex type on the wall face to Side. 

ii. Retain the default Interval size of 1 and click the Apply button at the bottom of 
the form. 

The pipe will be meshed as shown in Figure 3-15. 
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Figure 3-15: Pipe meshed by changing the vertex type on the wall face to Side 
 and using the Cooper meshing scheme 

! It may be useful to remove the mesh from the display at this point; it is then 
easier to see the faces of the geometry for the other two pipes. The mesh is 
not deleted, just removed from the graphics window. To remove the mesh 
from the display, click the SPECIFY DISPLAY ATTRIBUTES command button 

 at the bottom of the Global Control toolpad. Select the Off radio button 
to the right of Mesh near the bottom of the form and click Apply. 

2. Mesh the second pipe using the Submap scheme on the wall face of the pipe and using 
the Cooper meshing scheme to mesh the volume. 

By enforcing the Submap scheme on the wall face of the pipe, GAMBIT will 
automatically modify the vertex types on this face to honor the Submap scheme. 
The criteria for the Cooper meshing scheme will then be fulfilled for the pipe, and 
the pipe can be meshed using the Cooper scheme. 

a) Set the meshing scheme for the wall face to Submap. 

MESH  → FACE  → MESH FACES  

This command sequence opens the Mesh Faces form. 
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i. Select the wall face of the second pipe (shown in Figure 3-16) in the graphics 
window. 

Wall face of
second pipe

 

Figure 3-16: Wall face of the second pipe volume 
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ii. Select Quad in the Elements option menu under Scheme, and select Submap 
under Type. 

See the GAMBIT Modeling Guide for more information on the Submap 
scheme. 

iii. Retain the default Interval size of 1. 

iv. Deselect the Mesh check box under Options. 

You deselected the Mesh check box because at this point you do not want 
to mesh the face; you only want to apply the meshing Scheme to the face. 
GAMBIT will mesh the face using the specified Scheme when it meshes 
the pipe volume. 

v. Click the Apply button at the bottom of the form. 

b) Mesh the pipe volume using the Cooper meshing scheme. 

MESH  → VOLUME  → MESH VOLUMES  

This command sequence opens the Mesh Volumes form. 
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i. Select the pipe volume in the graphics window. 

Note that Hex/Wedge Elements and the Cooper Type are automatically 
selected under Scheme in the Mesh Volumes form because you enforced 
the Submap scheme on the side face of the pipe. 

GAMBIT automatically selects the source faces because you enforced the 
Submap scheme on the side face of the pipe. 

ii. Retain the default Interval size of 1 under Spacing and click the Apply button at 
the bottom of the form. 

The pipe will be meshed as shown in Figure 3-17. 

 

Figure 3-17: Pipe meshed using the Submap scheme for the wall face of the pipe and the 
project scheme for the volume 

! It may be useful to remove the mesh from the display at this point; it is then 
easier to see the faces of the geometry for the last pipe. 

3. Mesh one of the pipes by hand-picking the source faces and then using the Cooper 
meshing tool. 
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a) Select the third pipe in the graphics window. 

The criteria for the Cooper scheme are not fulfilled for this pipe, because 
GAMBIT cannot mesh the side face of the volume using the Map or Submap 
meshing schemes. However, you can force GAMBIT to use the Cooper scheme 
on this volume by selecting the Cooper scheme and then manually picking the 
source faces (the faces whose surface meshes are to be swept through the 
volume to form volume elements). When you click Apply, GAMBIT will 
automatically enforce the Submap scheme on the side face and modify the 
vertex types to honor the scheme selected. See the GAMBIT Modeling Guide 
for more information on using the Cooper meshing scheme. 

b) Select Hex in the Elements option menu under Scheme, and select Cooper under 
Type. 

c) Left-click in the Sources list box in the form, and then pick the source faces for 
the mesh by selecting all the faces of the pipe except the pipe wall. The faces are 
marked A through D in Figure 3-18. 

! Shift-middle-click on a face to deselect it and select the face next to it. You 
can also click Reset in the Mesh Volumes form to deselect all faces and 
volumes, and reset all parameters entered in the form. 
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The four faces to be selected are at opposite ends of the pipe, as shown in 
Figure 3-18. You can select the faces in the graphics window, or you can use 
the Sources pick list. 

A

DC

B

 

Figure 3-18: Source faces used to mesh one of the pipe volumes 
using the Cooper meshing scheme 

d) Retain the default Interval size of 1 under Spacing and click the Apply button at the 
bottom of the form. 

4. Display all the face meshes for the three-pipe intersection. 

You will only display the face meshes at this point because displaying the volume 
meshes would create a cluttered view in the graphics window. 

a) Click the SPECIFY DISPLAY ATTRIBUTES command button  at the bottom of 
the Global Control toolpad.  

b) Select the check box to the left of Faces. 

c) Select the On radio button to the right of Mesh near the bottom of the form. 

d) Click Apply and close the form. 
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The face meshes on the three-pipe intersection are shown in Figure 3-19. 

 

Figure 3-19: Face meshes for the three-pipe intersection 
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Step 9: Examine the Quality of the Mesh 

1. Select the EXAMINE MESH  command button at the bottom right of the Global 
Control toolpad. 

This action opens the Examine Mesh form. 

 

a) Select the Sphere option under Display Type. 
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This creates a section through the grid that is spherical in shape. For the 
three-pipe geometry, a spherical section displays more useful information 
than a planar section. 

The 3D Element type selected by default at the top of the form is a brick . 

b) Select EquiAngle Skew from the Quality Type option menu. 

c) Select the + option under Cut Orientation near the bottom of the form. 

The “+” option indicates that only elements on the positive side of the cut are 
displayed. For a sphere, this means that only elements on the inside of the 
sphere will be visible. The “0” option displays elements on the cut, and the “-” 
option displays elements on the negative side of the cut (the outside of the 
sphere in this case). 

d) Click the SELECT PRESET CONFIGURATION  command button in the Global 
Control toolpad. 

This divides the graphics window into four quadrants and displays a different 
view of the spherical section of the grid in each quadrant. 

e) Hold down the left mouse button on the X slider box in the Examine Mesh form 
and move it until the spherical cut is centered in the x direction in the graphics 
window. 

f) Move the Y and Z slider boxes to center the spherical cut in the y and z directions 
in the graphics window. The graphics window display is shown in Figure 3-20. 
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Figure 3-20: Spherical cut centered in the x, y, and z directions 

g) Move the R slider box in the Examine Mesh form to view the mesh on different 
spherical cuts in the graphics window. 

h) Hold down the left mouse button on the GRAPHICS-WINDOW SASH anchor, the 
small gray box in the center of the four quadrants of the graphics window, and 
drag it diagonally across the graphics window to the bottom right corner. 

This restores a single window. 

i) Close the Examine Mesh form. 

The spherical cut of the mesh will be removed and the face meshes will be 
restored. 
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Step 10: Set Boundary Types  

1. Remove the mesh and boundary layers from the display before you set the boundary 
types. 

This makes it easier to see the edges and faces of the geometry. The mesh and 
boundary layers are not deleted, just removed from the graphics window. 

a) Click the SPECIFY DISPLAY ATTRIBUTES command button  at the bottom of 
the Global Control toolpad.  

b) Select the Off radio button to the right of Mesh near the bottom of the form. 

c) Click Apply. 

d) Select the check box to the left of B. Layers and select Off from the option menu to 
the right of Visible near the bottom of the form. 

e) Click Apply and close the form. 

2. Set boundary types for the three-pipe intersection. 

ZONES  → SPECIFY BOUNDARY TYPES  

This command sequence opens the Specify Boundary Types form. 
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a) Define the flow inlet. 

i. Enter the name inflow in the Name text entry box. 

ii. Select ELEMENT_SIDE in the Type option menu. 

The specific boundary types will be defined inside the POLYFLOW solver. 

iii. Check that Faces is selected as the Entity. 

iv. Shift-left-click the end of one of the pipes (the face marked A in Figure 3-21) 
and click Apply to accept the selection. 
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CA

B

 

Figure 3-21: Boundary types for faces of the three-pipe intersection  

b) Define the two flow outlets. 

i. Enter the name outflow1 in the Name text entry box. 

ii. Check that ELEMENT_SIDE is still selected in the Type option menu and Shift-
left-click the end of one of the other pipes in the graphics window (the face 
marked B in Figure 3-21). 

iii. Click Apply to accept the selection of the face. 

iv. Set the Type for the end of the third pipe (the face marked C in Figure 3-21) to 
be ELEMENT_SIDE, using the Name outflow2. 

c) Define wall boundary types for the walls of the three-pipe intersection. 

i. Enter the name wall in the Name text entry box. 

ii. Check that ELEMENT_SIDE is still selected in the Type option menu and pick 
all the wall faces (the outer walls of the three pipes and the outer face of the 
sphere octant) in the graphics window. 

! You will select four faces in total. 
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iii. Click Apply to accept the selection of the faces. 

The boundaries for the three-pipe intersection are shown in Figure 3-22. 
(NOTE: To display the boundary types in the graphics window, select the 
Show labels options on the Specify Boundary Types form.) 

 

Figure 3-22: Boundary types for the three-pipe intersection 

Note that when GAMBIT writes a mesh, any volumes (in 3-D) on which you 
have not specified a continuum type will be written as FLUID by default. This 
means that you do not need to specify a continuum type in the Specify 
Continuum Types form for this tutorial. 
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Step 11: Export the Mesh and Save the Session 

1. Export a mesh file for the three-pipe intersection. 

File → Export → Mesh… 

This command sequence opens the Export Mesh File form. 

 

a) Enter the File Name for the file to be exported (intersection.neu). 

b) Click Accept. 

The file will be written to your working directory. 

2. Save the GAMBIT session and exit GAMBIT. 

File → Exit 

GAMBIT will ask you whether you wish to save the current session before you 
exit. 

 

Click Yes to save the current session and exit GAMBIT. 
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3.5 Summary 

In this tutorial, you created geometry consisting of three intersecting pipes. Before creat-
ing the mesh, you decomposed the three-pipe geometry into four volumes: the three indi-
vidual pipes and the wedge-shaped corner of the intersection (the sphere “octant”). These 
constituent volumes were readily meshed using GAMBIT’s Cooper and Tet Primitive mesh-
ing schemes. 

 

 

 

 

 

 


